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Introduction
This document will describe WKmini and its various interfaces. All the information you will need to
connect WKmini to your station will be included in this manual along with specific guides for
getting it working with N1MM+ Logger, HRD/DM780, N3FJP AC Log, and MRP40.

What is WinKeyer and why do I need it ?
Due to timing latencies inherent in multi-threaded operating systems like MS Windows, it is very
difficult to generate accurately timed Morse in software. All it takes is a higher priority task to
demand service and Morse generation will be delayed which results in wrongly timed dits, dahs,
or the spacing between them. A WinKeyer based device, like WKmini, attaches to a PC’s USB
port and appears as a serial com port to an application running on the PC. The application,
instead of generating Morse in software, sends the letters to WKmini. The application has full
control over sending speed as well as weighting, spacing, and PTT generation. WKmini has a
paddle interface so a user can break in immediately to handle fast exchanges in contest
situations. Electrically isolated keying outputs provide safety and prevent ground loops. Two
separate keying outputs allow the user to run two different radios from one keyer without
swapping cables. WKmini Rev B has two differences over Rev A. First, it uses a CH340 USB
controller instead of a FTDI controller in Rev A. The other difference is that Rev B moves Key 2
to the AUX port. Like Key 1, This port is optically coupled through a solid state relay. Maximum
voltage on either port is +/- 60 V.

WKmini Features
•
•
•
•
•
•
•
•
•
•
•
•

USB 2.0 Interface with Mini type 3 connector
• Uses K1EL’s latest WK3 IC
Iambic CW Paddle Interface
• Adjustable Speed 5-99 WPM
Iambic A, B, Ultimatic & “Bug” paddle modes
• Adjustable Weighting and dit/dah ratio
Two separate keying outputs
• Adjustable Keying Compensation
Only KEY1 has a PTT output.
• Adjustable Letterspacing
Solid state relay output rated at +/-60V @120 mA • Adjustable PTT lead in and tail delays
160 character input buffer
• Optional autospacing
External power not required, runs off USB power • Metal enclosure with RFI filtering
ESD protection on paddle input
• Auxiliary input for future enhancements
Firmware can be updated over USB
• 160 character input buffer
Embedded commands
• Inexpensive cabling options
Farnsworth spacing option
• Adjustable dit/dah ratio
• RTTY FSK transmit with WK3.1
• Works with any logging or contest application that supports WinKeyer !!

Product Warranty, Support, and Liability
WKMINI is fully warranted to the original purchaser against defects in materials and workmanship for one
year after purchase. This warranty does not cover damage caused by accident, improper care, or lightning
damage. Please contact us before returning your WKmini for repair and we will issue an RMA.
Please submit support questions by e-mail to k1el.kitsinfo@gmail.com
While every effort has been made to insure that the WKmini design is safe and the documentation is
clear and accurate, it is still possible to cause equipment damage or incur personal injury if:
WKmini is not used as intended, WKmini is connected incorrectly, Safety guidelines outlined in this
document are not followed, or WKmini is modified in any way.
K1EL cannot be held responsible in these or other similar events.
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USB drivers
Don’t plug WKmini into your PC until you have read this paragraph !!
WKmini uses a CH340N USB interface IC which is very reliable and easy to set up. Windows
drivers for this device can be found on the WKmini website. There are two versions, a self
installing .exe and a zip file containing the individual drivers as used by Windows Update. Please
read through Appendix A for our recommended install procedure.
Drivers for Mac and Linux are also available on the WKmini website. Contact K1EL if you need
guidance for those installations.

WKmini Connections

There are four connectors on WKmini, PDL and OUT on the left with AUX and USB on the right.
The PDL connector is an 1/8” stereo jack which accepts paddleset input. The paddle can be an
iambic or side swiper type. A bug is not acceptable. The paddle inputs are activated when
switched to common ground (GND). The paddle connector needs to be wired this way:
GND

DAH
DIT

Paddle Connector
The OUT connector is also an 1/8” stereo jack. It has two switched outputs; KEY 1 and PTT 1.
These outputs are isolated from WKmini ground and all other WKmini signals by an optically
coupled solid state relay which insures a 5000V barrier. These outputs can switch voltages up to
+/- 60 V, keyed currents up to 120 mA. The output connector is wired as shown below:
GND
Sleeve

Ring

PTT 1
KEY 1

Tip

Out Connector
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The AUX connector uses the same type connector as OUT. It provides a single switched output
for KEY2. Like OUT, this output is isolated from WKmini ground and all other WKmini signals by
an optically coupled solid state relay which insures a 5000V barrier. The output can switch a
voltage up to +/- 60 V, keyed current up to 120 mA. The output connector wiring is shown below:
GND

N/C
KEY 2

AUX Connector
PTT is only provided for KEY1 and is off by default. It can be enabled by software configuration if
necessary.
The USB connector is designed to mate with a Type A to
Mini-B cable. This cable is shown at left. The interface will
run at USB 1.0 and 2.0 speeds and will also work with a
USB 3.0 connector which is backward compatible with USB
2.0 interfaces by design.

WKmini contains no user serviceable or configurable jumpers, Please do not tamper with or
modify the internal circuitry of WKmini as this will void the unit’s warranty and may result in
unsafe operating conditions.

Let’s actually run WKmini !
Once the USB driver is installed and you have plugged WKmini into your PC, you can determine
WK’s port assignment using K1EL’s WKscan app: http://www.hamcrafters2.com/WKscan.html

WKscan Tutorial
After you have installed WKscan, start it
up and you will see the dialog box
shown at left. Click Scan and WKscan
will display all of the serial ports found
on the system. The ports will either be
identified as unassigned, in use, or
attached to a WK device. In this example
we have a WinKeyer1 device on COM2
and a WinKeyer3 device on COM4.
Yes, multiple WKs can be operated from
a single PC using two applications.

Once you know WK’s com port, you are ready to run WKdemo.

If WKscan won’t run on your PC
We’ve had feedback that WKscan will not run on all PCs. If this happens, please refer to
Appendix B which shows how to obtain com port assignments using Device Manager.

WKmini Rev B User Manual

10/16/2021

Rev 1.1

Page 4

K1EL

WKmini USB WinKeyer User Manual

WKmini B

WKdemo tutorial
WK3DEMO is a general purpose test
application that can exercise all of WKmini’s
capabilities:
http://www.hamcrafters2.com/WK3demo.html
Once the application is installed, start it up and
you will see the dialog box show at left. All you
need to do to get started is to configure the
serial communications port. Click on Setup and
the com port selection list is shown. Only the
currently active USB com ports are shown.
Select a WK com port identified by WKscan.
You can click on ? In the upper right for a very
brief help menu.
Click on Open to connect to WKmini. If all is
well, the Open pushbutton will change to Close
and the WK IC version will be displayed. Click
on Setup again and this time the Setup dialog
box will be displayed as shown on the next
page. This presents all of WK3’s various
configuration options which can be modified to
your requirements.

Click Cancel for now and go back to the main dialog box. Type into the lower keyboard entry
window and the test LED light will flash through the hole in the side of the enclosure. WKmini
does not have a local sidetone speaker so the sidetone LED is included for testing purposes.
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The sidetone options on the WKdemo setup display must be enabled. If serial echo is on in Setup
then what you type will be echoed in the upper text window as it is sent.
Now hook up some paddles and test paddle entry. If Paddle Echo is enabled, letters entered on
the paddles will displayed in the upper text window. It’s tricky to do this without an audible
sidetone. Use the Setup Dialog to try different keying options. Note that if you change settings on
the Setup dialog box, you have click Done and return to the main application to transfer those
new settings to WKmini.
Like sidetone, WKmini does not have a speed pot so those controls related to speed pot use are
disabled. That means it will function as if Speed Pot Lock was disabled. When Pot Lock is
unchecked, the Up/Down arrows next to the WPM readout on the main dialog box will control the
speed or you can directly enter a speed in the WPM edit box. In other words, speed is controlled
solely by the host application. This is how the majority of PC logging and contest applications
operate. Speed is controlled by keyboard commands, macros, or messages with embedded
speed commands. The name of the game in contesting is to have one central user focus, that
being the keyboard.
Although WKtest packs a lot of power in a small app, it is only meant to be a hardware test tool; it
gives you a good idea of what WKmini is capable of and confirms that it is operating properly. The
next logical step is to move on to a ‘real’ application, such as N1MM+. Before that we will briefly
look the WK3tools application.

WK3tools application
Normally when a WinKeyer device is not connected to a host application it will run in standalone
mode. Since WKmini has been designed to be a cost effective host only device, it does not
provide a useful standalone mode. It will operate when connected to a USB port, but since there
are no pushbuttons or a sidetone speaker, the user has no control over its operation. In other
words you can send at a fixed speed using a set of paddles but that’s about it. You really need to
run it from a PC application to be effective.
http://www.k1el.com/WK3tools.html
The WK3tools application is used to customize standalone settings, you can use this app to set
up a standalone configuration and it will work but as previously stated there aren’t many options
here. Any controls related to messages, users, and speed control are disabled. WK3tools is most
useful for updating the firmware on WK3mini. Current firmware versions are posted on the
WKmini website.
http://www.k1el.com/WKminiRevB.html
The procedure for updating WKmini can be found in Appendix D.
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Connecting WKmini to your station
Minimally all you need to do is connect the USB cable from WKmini to a USB port on your PC
and connect the key output to the keying input on your rig. Since WKmini performs the keying
function it drives your rig in the same manner as a straight key. In other words there are only two
leads, ground and key control. For that reason a keying cable is quite easy to build.
K1EL.com sells a universal keying cable kit that covers 95% of keying requirements.

Keying cable details (also see page XX)
An 1/8” stereo phone is recommended for the WKmini end of the keying cable and the other end
will have a connector that mates to your rig’s key input. Usually this is a 1/4 inch phone plug. A
two wire cable is all that is required to key a typical transceiver. Wire the key line to the tip of the
1/8” connector and ground to the sleeve as shown below, same for both OUT and AUX ports.
GROUND

GROUND
sleeve

No Connect
KEYLINE

sleeve

ring

No Connect

tip

KEYLINE

Keyer side of cable

ring
tip

Transmitter end of cable

On the transceiver end, the key line goes to tip and ground goes to the sleeve. Make sure you
disable the radio’s internal keyer (if it has one) and set it up for straight key operation. It’s always
a good idea to test your keying cable before using it with WKmini. Plug the cable into your
transceiver and leave the keyer end unconnected. Now set up your transceiver for transmit and
then at the keyer cable end, short tip to sleeve with a clip lead. If this doesn’t work then either the
cable is not made correctly or the radio is not in break in mode. If you get dits or dahs, then the
keyer in the radio is still enabled. Some transceivers want you to use a stereo plug even if the
internal keyer is disabled, it’s always a good idea to use a stereo connector at the radio end no
matter what and leave the ring unconnected. PTT is rarely required for most CW stations. It is
used for RTTY operation though.
If you want to key a transmitter with vacuum tube finals, WKmini will not work because its solid
state keying relay is only rated for +\- 60V switching at 120ma. Grid block voltages are always
greater than this. Same goes for cathode keying. WKUSB is a better choice for grid block keying.
WKmini’s keying connector is electrically isolated from WKmini’s enclosure and ground. This
means that you can directly connect your transceiver to WKmini with PC attached and not worry
about ground loops or RF getting into your PC through WKmini.
PTT Connection
As mentioned previously, PTT will not be used in most CW radio setups. It is provided to run an
external antenna switch or to pre-key a linear amplifier. If you are just driving a barefoot
transceiver, PTT will not be required.
If you do need PTT, WKmini provides useful functionality. PTT is asserted before KEY and is held
for the entire transmit interval. Both lead-in and tail delays are adjustable. Just wire PTT to the
ring of the keyer connector and configure WKmini for single radio keying (KEY1/PTT1). Make
sure that PTT is enabled in your configuration settings.
Refer to the RTTY section on page 11 to see how PTT is used in that mode.
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Paddle Connection
If you decide to use a set of keying paddles with WKmini, they plug into the paddle jack input on
the left side of the unit. An 1/8 inch stereo jack is used on WKmini, if your paddles have a 1/4 inch
size plug an adapter cable will be necessary.
WK3demo is useful for verifying that WKmini is keying your rig properly. If you run into problems,
make sure you have selected the correct key output port. This is done in the Output Config
control in the WKdemo setup dialog box. Also check to make sure the connector is fully plugged
into the WKmini jack. The tune function is useful for signal tracing.

A cheap path to a keying cable
In today’s world of iPhones and portable music players, 1/8” stereo to 1/8” stereo connectors are
very easy to find and are inexpensive. If your transceiver requires an 1/8” keying plug you are
done. If it needs a 1/4” plug, purchase an 1/8” to 1/4” stereo adapter.

Alternatively, an 1/8” stereo plug to dual RCA cable can also be used. In this case get two RCA to
1/4” connectors and you have a keying cable that can key two different radios.

The point is that you can come up with just about any cable you need by juggling cable types and
adapters. Or buy one of our cable kits from us.
Note that 3.5mm and 1/8” connectors are the same size, so don’t let that confuse you.

Troubleshooting hints
1) WKmini won’t key my radio. First check to make sure your keying cable is wired correctly
and then check to make sure it is plugged into either the KEY or AUX output. If you have
it plugged into PDL it won’t work. See if swapping AUX and OUT works, if so you have
port selection swapped.
2) I get dits or dahs only or the CW output is garbled. This usually happens when you have
not disabled your transceiver’s internal keyer. You need to enable straight key mode. In
most transceivers this function is controlled by menu selection, older radios may employ
a dip switch or jumper. Please check your radio’s user manual.
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3) When I plug WKmini into the USB port, I see an R flashed on the debug LED but nothing
else works after that. This is a sign that one of the dit or dah paddles are stuck low.
Remove the paddle connector and see if that clears the problem. If so you may have a
short in your paddle cable or paddle.
4) When I try to run WKmini from WK3demo I get the error message Attach WK: No Echo.
This means that the com port selected was a valid one but not the one that WKmini is
connected to. Recheck your port selection with WKscan or Device Manager (appendix B)
5) WKmini is plugged in but WKscan does not show a com port with a WK device. This is a
sign that either a USB driver has not been installed or the USB hardware on WKmini is
not working. It could be a bad USB cable, or bent pin inside the USB connector. Note that
the USB interface is factory tested before a board is shipped so if it doesn’t work the
places to look for trouble are limited to the connector and cable. It could be that the USB
cable is not fully inserted at either WKmini or at the PC.
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Theory of Operation
This section will briefly describe how WKmini works. As shown in the block diagram below, the
host PC is connected to WKmini over a USB com port. WKmini receives commands and Morse
letters from the PC. Letters will be sent in accurately timed Morse.
Display
WKmini

Host
PC

OUT

Commands
& Data
Keyboard

USB

USB

PDL

KEY1
PTT1/KEY2
AUX
Test LED

Keyer Paddle

PC to WKmini Block Diagram
Commands modify WKmini’s operation in some way, for example changing operating speed,
pausing transmission, or asking for status. Commands and Morse letters are processed
differently in WKmini. Morse is put into a FIFO* buffer memory that allows the host to send data
ahead of the Morse being sent. The size of this buffer is 160 bytes. Since there can be a
considerable delay from host input to Morse output, commands bypass the input FIFO and are
acted upon immediately. This allows changes to be made while sending is underway.
*First In First Out; bytes are taken out in the order they were put in.

USB Serial
Input

Morse &
Buffered
Commands

Input
Parser

Command
Bypass

160
byte
FIFO
to input processing

Data and Command Flow inside WKmini

Since there are times when you don't want commands to take effect immediately, WKmini allows
commands to be buffered. This means that the command is placed in the serial buffer mixed with
Morse and won’t be acted on until it comes out of the buffer. An example would be sending two
words at two different speeds, the first at 15 WPM and the second at 20 WPM. By placing a
buffered speed command between the words, the speed will not be changed until the first word is
completely sent.
WKmini will send data back to the host for processing. There are four reasons this will happen:
1)
2)
3)
4)

lnform the host of a WKmini status change.
Inform the host of a speed pot or pushbutton change.
Respond to a request for status from the host.
Echo Morse as it’s being sent by message or by paddles
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Paddle Input Priority
WKmini accepts input from either its host port or iambic paddle port. Paddle input will always take
priority and will interrupt host data, automatically clearing WKmini’s serial input buffer. When a
paddle break-in occurs, any additional serial data that arrives from the host will be processed, but
will be ignored unless it is an immediate command. After paddling ceases, WKmini will pause for
one word space time before it resumes serial data transmission.

USB Power Down Sensing
Unlike WKUSB, WKmini rev B is not able to sense when the host PC it is connected to goes into
standby. The recommendation is to set the PC’s power settings so that it will not be allowed to
time out and go into standby.

SO2R Mode
Since WKmini has two independent output ports, it is able to support SO2R mode under control
of the host application which manages port selection.

Serial Baud Rate
WKmini’s standard baud rate is 1200 baud with an alternate baud rate of 9600 selected by host
command. This is all handled by the host application so there is no need or requirement to set the
USB port’s baud rate, stop bit, or parity settings. All of these things are configured automatically
by the host application when it opens WKmini for use.

Reset WKmini/Restore Factory Defaults
There are cases when a host app misbehaves and can corrupt WKmini’s basic setup parameters.
We know of no app that does this but when under heavy use with RF floating around unexpected
things can happen, ESD is another issue that can cause this to happen. WKmini has very good
ESD suppression on all I/O ports, so again, not likely. The easiest way to restore WKmini’s
EEPROM settings is with WK3tools. First unplug WKmini from the PC and then plug it back in
after 10 seconds. Then start up WK3tools, set the com port and click WKtest to be sure it can
connect. Then simply click Reset to Defaults followed by WriteWK. That will restore WKmini to
factory fresh settings.

RTTY Operation
Rev B WKmini supports RTTY transmit operation. When in RTTY operational mode, the outputs
are assigned RTTY functions. By default the KEY1 is assigned to transmitter key while PTT is
assigned as the FSK control output. The function can be reversed if the user prefers Key to be
FSK and PTT to be Key. Diddle, mark/space reverse, UOS, and speed selection can all be
controlled by host command. This will be made clear in the section that shows how to run RTTY
with WKdemo starting on Page 30.
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ASCII Code Assignments, Prosign Mapping
WKmini maps several unused ASCII codes to standard prosigns as shown in the table below.
Additional prosigns can be generated using the merge character command. Some abbreviations
are not mapped (null), WK will ignore these if received. Codes below 0x20 are commands, 0x30
to 0x39 are numerals 0-9, 0x41 to 0x5A are letters A-Z. All codes above 0x5D are ignored except
for | (0x7c) which is the ½ dit pad code.
ASCII Hex
0x20
!
0x21
“
0x22
#
0x23
$
0x24
%
0x25
&
0x26
‘
0x27
(
0x28
)
0x29
*
0x2A
+
0x2B
,
0x2C
0x2D

Prosign
Is space
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is comma
Is mapped to

(null)
RR
(null)
SX
(null)
(null)
WG
KN
KK
(null)
AR

ASCII
.
/
:
;
<
=
>
?
@
[
\
]
|

Hex
0x2E
0x2F
0x3A
0x3B
0x3C
0x3D
0x3E
0x3F
0x40
0x5B
0x5C
0x5D
0x7C

Prosign
Is period
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is question
Is mapped to
Is mapped to
Is mapped to
Is mapped to
Is ½ dit pad

DN
KN
AA
AR
BT
SK
AC
AS
DN
KN

DU

Table 1 – Prosign/Abbreviations Assignments
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N1MM Interfacing
You will first need to know your WKmini’s comport assignment, if you don’t know it, follow the
WKscan Tutorial on page 4.
Now start up N1MM+ and click on the Config Tab and then select the entry as shown:

This brings up the Configurer dialog box. This is where devices attached to N1MM+ are set up.
For this example we will set up a WinKeyer device on COM2.
1) Select COM2 from the drop down box.
2) Specify that it is a CW device by clicking the CW/Other checkbox
3) Continue on to the Com Port setup dialog box by clicking Set
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Clicking Set brings up the Com2 configuration dialog box. All we need to do here is click the
WinKey checkbox, leave all the other settings as is.

Now click OK to close the Com2 configuration dialog box which brings us back the Configurer
dialog box. Here we select the Winkey tab as illustrated below:

Clicking on the Winkey tab brings up the WinKeyer specific configuration dialog box which is
shown on the next page.
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There are very descriptive hints on most of the controls.
Winkey 2 options also apply to WK3 based keyers.
Disable Paddle Only Sidetone for initial testing purposes.
Winkey Speed Control has three options:
1) Ignore Speed Pot which only allows the host to control sending speed
2) Use Speed Pot which tells the host that the speed pot will set sending speed
3) Paddle & Keyboard where the host controls only the message speed
Lead and tail settings apply to PTT delay Keying compensation adjusts dit and dah spacing
relative to sending speed.
Hang Time is similar to PTT tail except that it is proportional to sending speed.
When you are finished, click OK and then another OK to close the Configurer. Now that we are
back to N1MM+ main control dialog box we can do some WKmini testing. First off select CW
mode by clicking on a band in the CW column:
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Now on the PC's keyboard enter CTL-T to put WKmini into tune mode. Cancel tune mode by
entering CTL-T a second time. With tune enabled you should hear sidetone coming from WKmini.
Now either enter CTL-K or select the CW Key Window as shown:
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The CW keyboard window is now displayed and you can type into it to send letters to WKmini.
Note that when the Send CW window is up, the main N1MM+ dialog box is disabled. For a final
test, turn the speed pot and you should see the CW Speed display in the main N1MM+ dialog box
change. (This assumes that the speed pot has been enabled in the Winkey configuration dialog
box)

That's it for basic N1MM+ and WKmini testing. Now it's time to learn all the amazing features in
N1MM+ for setting up messages and getting up to speed with automatic CW contest exchanges.
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Running WK 3.1 with N1MM+ in RTTY mode
Since WKmini has a WK 3.1 controller IC, you can run it with N1MM+ in RTTY mode. Bring up
the Configurer dialog for Winkeyer and you will see a new RTTY mode selection option:

Click on Enable RTTY and then set a delay in both Lead Time and Tail Time; 40 mSec in each is
a good starting point. Now click on the Configurer Digital Modes tab and in the left most drop
down, select Winkey. Now close the Configurer and go back to the main N1MM+ window. From
there we will open up the digital interface window:

There are several things to set up in the digital interface window, first we will setup the macro
keys for Tx, Rx, and ESC. Carefully follow the next instructions.
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Click Setup->Settings to bring up the Digital Setup Window, click on the Message Setup tab and
then select “Other, TinyFSK, Winkey” from the drop down menu.

Using the picture below as a guide, click Tx, then enter [ in the message Text Window followed
by Save Settings. Repeat this process by entering ] for Rx and then \ for ESC. Note that you
have to re-select “Other,TinyFSK,Winkey” each time.
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The fastest way to get into RTTY mode is to enter RTTY in the entry box as shown and hit Enter.

Now go back to the Digital Interface window, and select your desired RTTY operational modes:

Now you are all set to run N1MM+ in RTTY mode with WKmini. Entering an Fn macro key will
trigger its message and you will see the RTTY string echoed in the Digital Interface Window as
they are transmitted. You can enter free test in the Digital Interface Window by first clicking the Tx
button, and then typing into the input edit window. When you are done typing, click Rx or enter ]
and N1MM+ will go back into listen mode. Clicking Esc:Stop in the main window or hitting the
ESC key will halt transmission immediately.
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HRD Interface Guide
You will first need to know your WKmini’s comport assignment, if you don’t know it, follow the
WKscan Tutorial on page 4.
Start HRD and click on the DM780 icon in the upper left corner of the application. If it’s not visible,
you may have to enable program view as show on the left. (View->Program)

DM780 takes a few moments to start up, once it does, select CW mode from the mode list and
then from the CW tab, select CW(Winkey):

This brings up the Winkeyer dialog box which has multiple tabs with a great deal of configuration
choices. We will start with the Keyer Tab where we set WK’s com port and then click Connect.
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Now Connect changes to Connected and items in the dialog box are no longer grayed out. If you
click Auto-connect, DM780 will connect to Winkeyer automatically on startup.
A speed slider allows you to change WinKeyer
speed while you are in this dialog box for
testing. Keyer mode displays a choice of
paddle input options. Iambic B is the most often
used so that is the default. If you select
Ultimatic, three different variants for this mode
are enabled
Autospace applies to paddle input only while
contest spacing applies to message sending.
When contest spacing is on, wordspaces are
reduced to 6 dit times vs. standard 7 dit times.
Select paddle echoback and paddle entry will
be displayed in with message sending. When
paddle watchdog is on, transmit is disabled
after 128 consecutive dits or dahs.
Paddle swap allows you to select dits on the
right paddle instead of left.
Serial loopback must be on in order for DM780
to keep track of outgoing Morse.
If you click on Test, a canned message will be
sent with status displayed.

WKmini Rev B User Manual

10/16/2021

Rev 1.1

Page 22

K1EL

WKmini USB WinKeyer User Manual

WKmini B

If you click on the PTT/Sidetone tab a list of
hardware options are displayed. Winkeyer1
settings are historical and can be ignored.
Even though WKmini uses a WinKeyer 3 IC,
the Winkeyer2 settings are the ones we are
concerned with. This is where you setup the
output port operation. If you want a single key
port with PTT, click PTT enable and PTT Port
1. If you want two separate output ports don’t
click any of these options.
Sidetone frequency is irrelevant for WKmin
since it does not have built in sidetone
capability.

The Speeds Tab is mostly concerned with
speed pot settings. Since WKmini does not
have a speed pot, we will unclick track
changes.
Farnsworth can be enabled if desired but
for practical purposes, it is used mostly for
code practice and doesn’t apply to normal
amateur radio exchanges. But it’s there if
you want it.
Note that the WinKeyer IC version is
displayed at the top of this dialog box.
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The Options tab contains settings to
adjust the timing of the Morse sent by
WinKeyer. These settings are discussed
in detail in Appendix D of this document.
Also listed are settings for PTT timing.
PTT turns on before sending starts and
shuts off after sending is complete. Lead
specifies how long PTT will turn on
before keying starts. The Tail delay
specifies how long PTT will stay on after
keying ends. There is a separate tail
delay setting for paddle sending called
hang delay. Most operators want PTT to
not drop out between letters but also
drop out very soon after they stop
sending. Hang time sets the delay in
wordspace times making it proportional
to sending speed.

Now WKmini is ready to work with HRD/DM780. It is a very complex and multi-featured
application and I am only able to cover just the WKmini interface portion. It will take some time to
get familiar with the application.
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N3FJP AC Log Interface Guide
Start AC Log. From the main application page, select the Settings->Transmit->CW Setup tab.

That will bring up the CW Setup Form shown below. A list of the active com ports are shown, click
on the one WKmini is assigned to. Next select Winkeyer and then click Configure Winkeyer.
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This brings up a form that presents the Winkeyer options that can be modified. First thing to do is
click Open. That connects AC Log to WKmini, the status will change to Open and WKmini’s
firmware revision will be displayed. Most of the options should be familiar; any that aren’t can be
referenced in Appendix D. The only thing to be aware of is that WKmini does not have a sidetone
speaker or a speed pot, so those options will not have any effect on WKmini’s operation.
Sidetone enable has to be turned on in order for WKmini’s debug LED to work.

Click Done and you will return to the CW Setup form, you can enter messages in the F1 through
F11 slots. F1 is set up as a repeating message with adjustable loop delay. When you click Test,
the message in slot F9 will be sent. Click Save Settings to save you configuration and then click
Done to return to AC Log where you can start using WKmini on air.
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MRP40 Interface Guide
This is one of my favorite applications to use with WKmini. It’s not a logging program but instead
it’s a conversational, Morse terminal. It has an excellent CW reader that uses your PC’s sound
card to perform DSP tone detection. CW reception is displayed in a multi-channel, sideways,
waterfall display. The best part is that it includes a WinKeyer interface allowing you can send as
well as receive. It’s very easy to hook up WKmini. From the main page, click:
Options->Tx Settings->Send via Winkeyer

A simple WinKeyer configuration dialog box is
displayed. Enter the com port number as reported by
WKscan and click Save. WKmini is now active and
you can set up configuration options. Select paddle
Keyer Type, Iambic B is most commonly used. Then
if you want to use a single key port with PTT select
Key Port 1 and Ptt, else select either Key Port 1 or
Key Port 2 leaving Ptt off. Enable sidetone so that
WKmini’s debug LED will work.
Click and hold Tune and WKmini will key it’s output
until you release. To get back to the main
application, click on the X in the upper left corner of
the dialog box.

Now simply type in the lower text window and Morse will be sent by WKmini. I recommend setting
TxSpeed=RxSpeed in TX Settings, that way if you copy someone you want to work, your transmit
speed will be set to match theirs automatically. I also like to adjust the text size to display more
lines. That option is under Display.
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FLdigi Interface Guide
This is another very powerful amateur radio application. It’s quite easy to set FLdigi up to use
Winkeyer in either CW or RTTY mode. If you don’t know the comport that your WKmini is
connected to, use our WKscan app. To start, we need to setup WinKeyer configuration:

Selecting WinKeyer will bring up the following configuration dialog box,

Enter WKmini’s com port and the review the default Winkeyer settings. For the most part, the
defaults will suffice but you may want to change paddle swap or use a different keyer mode. Click
on Connect and FLdigi will open up the WK interface. The following message will displayed on
the main application window to indicate that the interface is open and ready to operate:

WKmini Rev B User Manual

10/16/2021

Rev 1.1

Page 28

K1EL

WKmini USB WinKeyer User Manual

WKmini B

Once Winkeyer has been selected and configured, FLdigi will open it automatically when is starts
next time so you won’t have to go through this setup procedure every time.

Running WK3 with FLdigi in RTTY mode
Since WKmini uses a WK 3.1 controller IC, you can run it with FLdigi in RTTY mode. Bring up the
configuration dialog and select the TTY tab and the Winkeyer 3 tab:

All of WK’s RTTY settings are presented here. Select the correct com port and adjust the defaults
as required then click connect.
To set RTTY mode in the main operating window, simply choose Op Mode followed by RTTY at
the speed you want to run at. WK RTTY operation, like WK CW, is well integrated into FLdigi and
once set up you should be good to go. FLdigi offers excellent documentation on how to run their
application and that is the best place to go if you need help getting started.
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Running WK3demo Version 4.0 in RTTY mode
An easy way to test out WKmini 3.1 in RTTY mode interface is to run it with WK3demo 4.0. Since
WKdemo only does RTTY transmit, you will need a means to read and decode received RTTY
signals. You could use the popular apps MTTY, FLdigi, or some other PC based RTTY decoder.
Many amateur radio transceivers have RTTY decode built in which would make this very easy.
WK3demo 4.0 has a new RTTY menu that is enabled when you connect with a keyer that has a
version 3.1 WK IC. This is what you should see when you open WKmini and it has WK3.1:

Now if you click on setup you will be able to access the RTTY controls:

These are the recommended settings that will satisfy most setups. First of all, select RTTY
Enable, Diddle, and RTTY monitor. The only other settings that you may have to adjust in this
group are FSK Map and Reverse. FSKMAP will swap the PTT and KEY Outputs. Normally WK’s
KEY out goes to your transceiver’s KEY input and PTT goes to the transceiver’s FSK input.
FSKMAP will swap these two outputs. We will run in direct FSK mode, not AFSK so we connect
to the digital FSK input not a mic input. Selecting RTTY monitor will echo letters to the transmit
window as they are being sent.
Be sure to enter values for PTT Lead In and Tail. This will insure that the beginning and end of
your RTTY transmissions do not get chopped.
Click on Done to get back to the main menu. Once RTTY enable is set, WK will act quite
differently. It will not send CW, only RTTY. Let’s send a test CQ, first we enter a [ in the entry
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window. This will key your transceiver and assert the FSK output to the mark state. Since we
selected Diddle on, it will start sending blank characters until we actually enter some text.

As we enter text it will be echoed to the upper window after it is sent. When you are finished,
enter a trailing ] which will unkey the transceiver so you can listen for a reply. It may be helpful to
monitor your transmission to be sure you are operating correctly. If KEY and PTT are swapped
you will hear the transmission clipped on and off since it is being keyed by FSK. When it’s set up
correctly the transmit output will be on all the time and be frequency shift keyed by FSK. Note that
it might be necessary to toggle Reverse. The best way to tell is to listen to other stations and set
Reverse to match their shift polarity.
If you want to insert a CRLF sequence enter the } character. Two other actions you may need are
Pause and Clear, both of these work by clicking the appropriate button. Tune will key the
transceiver with no FSK.
Now let’s enter an RTTY message. On the WK3demo main dialog box, move the cursor over a
message button and right click on it. The following dialog box will be presented:

We start an RTTY message with [ and end it with ]. Note that a CRLF token } is included at the end
just before the ] so that a CRLF will be sent at the end of the message. Save the message and now
when you left click the message button your message will be transmitted.

WKmini Rev B User Manual

10/16/2021

Rev 1.1

Page 31

K1EL

WKmini USB WinKeyer User Manual

WKmini B

Interfacing WKmini to other applications
The basic procedure will be the same for other apps that use Winkeyer. Some apps first require a
port mapping procedure like N1MM or HRD while others take you directly to the Winkeyer
interface dialog box where you select the port and set up the configuration. If you run into any
problems, first contact the application developer since they will be able to offer the best help. If
that is not possible post an inquiry on the K1EL Yahoo Group. Odds are that there is someone
else in the group who has used the app and they can give you first hand advice. If no one picks
up the trail, we will jump in and do what we can. Note that we have a large list of apps that
support WinKeyer on our website.

Support and Warranty
WKmini is fully warranted to the original purchaser against defects in materials and workmanship
for one year after purchase. This warranty does not cover damage caused by accident, improper
care, or lightning damage. Please contact us before returning your WKmini for repair and we will
issue an RMA. Please submit questions by e-mail to k1el.kitsinfo@gmail.com
Watch the Hamcrafters website for updates and new products: http://www.hamcrafters.com

While every effort has been made to insure that the WKmini designs is as
complete and accurate as possible it is still possible to cause equipment
damage or incur personal injury if:
WKmini is not used as intended.
WKmini is connected incorrectly.
Safety guidelines outlined in this document are not followed.
WKmini is modified in any way.
K1EL or Hamcrafters cannot be held responsible in these or other similar
events.
Watch the Hamcrafters Website for latest updates and new product offerings:
http://www.hamcrafters.com
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Appendix A - Installing the CH340 USB Driver for WKmini
As mentioned, don’t plug WKmini in yet, we have to deal with the USB driver first.
For Windows, first thing to do is create a folder on your PC called CH340 or something similar,
the name doesn’t really matter. Then download both CH340?? And Windows??? from the
WKmini website and copy them into the new folder. Unzip the Windows… file.
Now plug WKmini into your PC and wait to see if Windows Update will automatically search for a
USB driver. This usually doesn’t happen, but if it does click Skip obtaining driver….

Windows will then look on your local hard drive for the driver and will install it automatically.

If Windows Update did not start, simply run CH341.exe and this dialog box will be displayed:

Click Install and after a few minutes, the following message box will be displayed:

Now we can return to page 3 to continue WKmini hardware setup and testing.
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Appendix B – Wkmini USB COM port assignment information
Win 7 and newer Com Port Viewing and Reassignment
First of all we need to get a device list. The easiest way to do this is to click the Start button in the
lower left which will bring up a search edit box.
Enter Device Manager and hit return.

That will bring up a list of active devices

WK’s port will be listed under Ports (com & LPT). If more than one USB Serial Port is listed
disconnect WKmini’s USB cable and see which device entry is removed. Now you know
WKmini’s com port assignment. In this example it’s 33 which may not work with all WK apps. To
change it, double click WKmini’s USB Serial port entry to view the port properties dialog box.
Click on Port Settings Tab:

Then click Advanced:

Click the down arrow on the list box:

Now you have a choice of ports

Since Windows does not do a great job of keeping track of USB ports when a device is removed,
there are usually lots of stale port assignments that are still tagged as in use. It’s usually pretty
easy to determine which ports are not in use and reassign one of those to WKmini. If you choose
something under 15 you are probably not going to have port issues with any WK application.
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You will get this pop up when you pick an ‘in use’ port. If you are sure the port is not assigned to
any other serial com device, click Yes and then continue on to close all remaining dialog boxes.

WinXP Com Port Viewing and Reassignment
To start, move cursor to lower left corner of the screen and left click on Start. Then…
1) Right click on MyComputer and 2) Right click on Properties:

Right click on Hardware:
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Look for USB Serial Port (COMx) x is the port

In the example above, the USB com port assignment is 4. If you have multiple USB Serial Ports
listed and you are not sure which one is WK, disconnect WK from the computer and see which
one is removed from the list. Then just plug back in and make a note of the assignment.
Sometimes the port assignment may be in the 30s, 40s, or even higher. Windows does not do a
great job managing port address when a USB com port is unplugged. Instead of deleing unused
ports it just keeps assigning higher and higher port values. Some applications don’t allow com
ports higher than 10 so you might want to change the port assignment. Go back to the device list
as shown above and double click on the WK’s USB Serial Port entry. That will bring up the USB
Serial Port Properties dialog box.
Click on Port Settings:

Then click on Advanced:

This brings up the Advanced Settings dialog:

Click the down arrow to expand the port list:

A list of available com ports is shown, select the desired port and click OK. Windows will warn
you that the port is in use but as long as you are sure the port is free then click OK. Now close all
remaining com port related dialog boxes and you are finished.
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Appendix C – WinKeyer Settings Defined
Weighting
A proportional amount is either added or subtracted from the length of all transmitted dits and
dahs. A value of 50 selects no weighting adjustment. Values less than 50 reduce weighting and
values greater than 50 increase weighting. Note that weighting does not affect sending speed
because any increase in keyed time is subtracted from spacing time. Reduction in weighting
results in a thinner sounding keying while increased weighting results in a heavier sound. Since
weighting tracks speed, a given weighting will sound the same at all speeds.
WEIGHTED DIT TIME =
(((WEIGHT×50)/50)×DIT TIME)

Decreased Weighting
Normal R

WEIGHTED DAH TIME =
(((WEIGHT×50)/50)×DAH TIME)

Increased Weighting

Weighting Example

Keying Compensation
A fixed amount is added to the length of all dits and dahs. QSK keying on modern transceivers
can cause shortening of dit and dah elements which is especially noticeable at high speeds. WK3
can compensate for the shortening by adding a uniform length to each dit and dah element. The
adjustments are made in one-millisecond steps and the maximum adjustment allowed is 250
mSecs. Key compensation is very similar to Weighting in that an adjustment added to a dit or dah
is then subtracted from the spacing between them so the overall speed is not changed. The
difference between weighting and compensation is that compensation is independent of speed,
so if 10 msec of key compensation is selected, 10 msec will be always be added regardless of
speed. Be aware that at high speeds, large values of key compensation can reduce inter-element
space to zero.
In the following figure, an R is represented without key compensation (nn = 00) and with 12
mSecs of key compensation (nn = 12). Note that each dit or dah starts at the same place even
with compensation on.
Normal R
Key Compensation
Keying Compensation Example

Letterspace
Specifies an additional letterspace, in percentage of a wordspace, to be applied between all
letters. Minimum adjustment is 0% while maximum addition is 62%.

Paddle Sample Delay
This setting controls when WK3 will start looking for a new paddle press after sensing the current
one. If there is not enough delay, the keyer could send unwanted dits or dahs. If there is too much
delay, the operator is held back because they can't paddle ahead. The default value is one dit
time (50) and is adjustable in percent of a dit time. A setting of 55 – 65 may seem familiar to
Accukeyer users. If the paddle sensitivity is set to zero, dit and dah paddle memory is disabled.
The delay is calculated with this formula:
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DELAY_TIME = (SWITCHPOINT×DIT_TIME)/50 where Switchpoint is a value between 10 and 90.

Dit/Dah Ratio
The ratio between the length of a dit vs. the length of a dah is controlled by this setting. The
agreed upon standard s ratio is 1:3 (dit:dah), a dah is three times longer than a dit.
The formula to determine dah/dit ratio is: DAH/DIT = 3∗(nn/50)
A value of 50 selects 1:3, a value of 33 would select 1:2, and a value of 66 would select 1:4. Any
value other than 50 causes distortion of the Morse waveform. Some ops use this option to make
their CW sound less “machine like” but a little goes a long way !
1:2 Dit \Dah Ratio
Normal Ratio
1:4 Dit \Dah Ratio

Three ratio settings for the letter R

PTT Lead and Tail Times
WK3’s PTT output is used to control an accessory device in addition to normal CW transmitter
keying. In most cases this device is a linear amplifier but it could be an antenna changeover relay
or PTT input of a transmitter. In all of these cases there are delay requirements that must be met
to insure that the accessory device is switched on before transmission begins and is held on until
transmission completes. This prevents damage to the accessory device due to hot switching.
WK3 provides three independent PTT delays to meet this requirement.

PTT

Lead-in Delay

Tail Delay
The letter A

Key

PTT Lead-in and Tail Example

The first of these is Lead-In delay which initiates a keying event. When transmit starts, PTT will be asserted
first and then, after the Lead-In delay expires, the key output will be asserted. Lead-In can be set to a value
from 0 to 250 milliseconds in 10 millisecond increments.
Tail Delay specifies the amount of time PTT will be released after Key is released. Like Lead-In delay, it is
adjustable from 0 to 250 milliseconds in 10 millisecond increments.
In setting tail delay there are two considerations, the first is to prevent hot switching and the second is to add
delay to fill in between letters sent by paddle. Most ops don’t want their amplifier to be switched in and out
between letters. An issue arises in that Tail delay is not solely proportional to sending speed. This is
problematic when someone sets a comfortable tail delay at a slow speed and then increases the speed to a
much faster rate. At the faster rate, the tail delay will hold too long after keying stops. Alternatively, if a
comfortable delay is set at a faster WPM rate, PTT will then drop out between letters at a slower speed. To
solve this problem, paddle tail delay is governed by a separate parameter called hang time.
Hang Time is adjustable in four steps and is measured only in wordspace and dit times rather than fixed
milliseconds. This means that the delay will accurately track sending speed. In other words it will decrease
automatically as sending speed increases and vice versa. The four settings for Hang Time are:
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HangTime = 2:
HangTime = 3:
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wait 1 wordspace + 1 dit before ending paddle insertion
wait 1 wordspace + 2 dits before ending paddle insertion
wait 1 wordspace + 4 dits before ending paddle insertion
wait 1 wordspace + 8 dits before ending paddle insertion

To sum up, Tail delay should be set to provide just enough delay to prevent hot switching for machine sent
CW while hang delay is designed to hold PTT between letters independent of sending speed. PTT will
automatically be held between machine sent letters and words but will drop out quickly after a message has
been sent as long as there is no trailing wordspace.

Paddle Watchdog
A paddle watchdog counter disables keying output after 128 consecutive dits or dahs. WK3
assumes that this is an unintended condition. This watchdog can be disabled if desired.

Paddle Swap
This bit swaps the operation of the dit and dah paddles. It’s used mostly to accommodate left
handed ops or to correct for a miswire in a keying cable.

Paddle Only Sidetone
Local sidetone is generated only for paddle generated Morse, sidetone is inactive when text is
sent form the host. Since WKmini does not have local sidetone this command is ignored.

Paddle Mute
This locks out the paddle so that it will not generate Morse when pressed.

Paddle Echo back
When enabled, all characters entered on the paddles will be echoed back to the host.

Serial Echoback
Serial Echo Back tells WK3 to echo each Morse letter that originated at the host. It can be used to
allow a host application to stay exactly in sync with Morse letters as they are sent. Each letter is
sent to the host after it has been sent in Morse. This permits the host to track WK3’s progress in
real time. Note that buffered commands and their parameters are not echoed back to the host.

Autospace
Autospace works in the following way: If you pause for more than one dit time between a dit or
dah, WK3 will interpret this as a letter-space and will not send the next dit or dah until the full
letter-space time has been met. The normal letter-space is 3 dit spaces. WK3 has a paddle event
memory so that you can enter dits or dahs during the inter-letter space and WK3 will send them
as they were entered. With a little practice, autospace can help you to send better.

Contest Spacing
When contest spacing is enabled, wordspace time is reduced by one dit. Instead of seven dits per
wordspace, contest spacing selects six dits per wordspace. The idea is that exchanges can be
sent faster with reduced space between words.

Paddle Keyer Modes
There are six different keying modes supported by WK3: Iambic mode A, Iambic mode B, Straight
Key/Bug, Ultimatic, Dit priority mode, and Dah priority mode. In either iambic mode, alternating
dits and dahs are sent while both paddles are held closed. In mode B an extra alternate dit or
dah is sent after both paddles are released. In straight key/bug mode a dah paddle press will key
the transmitter for as long as the paddle is pressed and dits will be generated automatically when
the dit paddle is pressed. In Ultimatic mode, when both paddles are pressed, the keyer will send
a continuous stream of whichever paddle was last pressed. Hold dah then press dit->sends dits.
Hold dit then press dah -> dahs are sent. Ultimatic dit and dah priority mode will generate dits and
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dahs automatically in response to single paddle presses, but when both paddles are pressed
either dit or dah has priority.

Speed Pot Lock (not applicable to WKmini)
This tells WK to ignore host speed control and to instead lock the current sending speed to the
speed pot.

Speed Pot Minimum and Maximum
The limits for the speed pot can be specified. The minimum must be greater or equal to 5 while
the maximum must be less than or equal to 99 WPM. This allows the speed pot to be tailored to
the user’s needs.

Sidetone Enable
Sidetone can be turned on or off. Local sidetone is not needed if the user is going to use the
sidetone generated by the transceiver they are using. This is the case in the majority of setups.
That’s why WKmini does not have a built in sidetone speaker. The enable control is used instead
to enable or disable the debug keying LED.

Sidetone Frequency (not applicable to WKmini)
WK3’s local sidetone frequency is adjustable in fine increments from about 500Hz to 4000Hz

SO2R Enable (not applicable to WKmini)
This is a special mode that is only applicable to WK keyers that have two keying outputs, each
with a dedicated PTT output. WK3 provides a basic SO2R capability. When SO2R mode is
enabled, PTT operation is modified. PTT1 becomes a radio select output while PTT2 becomes a
common PTT output for both ports. To utilize PTT for two radio setups requires additional gating
as illustrated below:

The PTT outputs on WKMINI are open collector so pull up resistors are required to generate logic
high and low conditions. PTT1 will be logic zero when radio 1 is selected and logic one when
radio 2 is selected.
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